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At this point we have covered a lot of material on the Jaguar CTS application serve
introduction of new Jaguar concepts and the basic administration of the server a
important for laying the groundwork for understanding how to build a distributed app
tion. In the next two chapters, we will build a Hello World application to demonstrate 
a basic PowerBuilder/Jaguar application is developed. Using this simple example, w
also explore how to use the wizards to speed development.

914914914914 3RZHU%XLOGHU#DV#D#FRPSRQHQW#PRGHO3RZHU%XLOGHU#DV#D#FRPSRQHQW#PRGHO3RZHU%XLOGHU#DV#D#FRPSRQHQW#PRGHO3RZHU%XLOGHU#DV#D#FRPSRQHQW#PRGHO

Jaguar supports several different component models, including PowerBuilder. The 
erBuilder component model is based on the custom-class user object, more com
known as the nonvisual user object (NVO). The custom-class object is used to build
cessing objects that have no visual properties. The NVO is the building block of a di
uted application in which all the application functionality and data access is writte
has functions and events, collectively known as methods and variables which ar
known as attributes. The NVO represents an object class and is used to group relat
cesses and encapsulate business and systems functions, promoting true-code reus

 The custom-class user object is a very simple object derived from the PowerBu
NonVisualObject system object. It has no visual properties and contains only two ev
the constructor and the destructor. It also supports the most basic set of PowerB
functions:

■ ClassName

■ GetContextService

■ GetParent

■ PostEvent

■ TriggerEvent

■ TypeOf

91414914149141491414 %XLOGLQJ#D#FXVWRP0XVHU#REMHFW%XLOGLQJ#D#FXVWRP0XVHU#REMHFW%XLOGLQJ#D#FXVWRP0XVHU#REMHFW%XLOGLQJ#D#FXVWRP0XVHU#REMHFW

The nonvisual object class is created in the User Object painter. Only a custom-clas
object can be deployed as a Jaguar component. To create a new NVO, choose File
from the main menu or click on the New toolbar option. The New Wizard dialog box 
open, as shown in figure 6.1. Select the Object tab and click on the Custom Class i

 This will launch the new User Object painter as illustrated in figure 6.2. As you
see, the development environment has under gone a radical change in PowerBui
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 fea-
As you step through the development of a user object, you’ll see some of the new
tures highlighted.
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 The custom-class object can be deployed as a Jaguar component as long as 
the guidelines established by Jaguar and CORBA 2.2 IDL are broken. To insure th
object will be compatible with the Jaguar server, check the Jaguar Validation optio
the main menu under the Design menu item. When Jaguar validation is turned o
object will be inspected every time it is saved. Any code that the Jaguar server do
support will be flagged. The restrictions Jaguar places on object development are
ered in chapter 9, which provides more details on Jaguar component development.

 To build a Jaguar component in PowerBuilder, follow these steps:

1 Create a new custom-class user object or inherit from an existing one.

2 Add the appropriate methods and variables to the object.

3 Set up the Jaguar component project.

4 Deploy the Jaguar component.

 Three new events have been added to PowerBuilder to support Jaguar compo
Jaguar calls these events at various stages of the component instance’s life cycle
6.1 lists the events that need to be added.

 The Activate and Deactivate events take the place of the constructor and dest
events when using instance pooling and building a stateless component. The C
Pooled event is used to tell the Jaguar server whether or not the component instan
be pooled. This event is called when the Pooling component property is disabled. 
Pooling component property is enabled, the component instance is pooled and the
is not invoked. These events are covered in more detail in chapters 8 and 9.

 For the developer building Jaguar components, there is a built-in wizard that m
creating a Jaguar component even easier. The wizard walks the developer through
steps involved with creating a custom class user object and the Jaguar Comp
project that is used to deploy the object to the Jaguar server. The wizard also ad
events activate, and deactivate to the NVO automatically.

7DEOH#914 (YHQWV#WR#EH#DGGHG7DEOH#914 (YHQWV#WR#EH#DGGHG7DEOH#914 (YHQWV#WR#EH#DGGHG7DEOH#914 (YHQWV#WR#EH#DGGHG
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Every PowerBuilder application requires a PowerBuilder library (PBL) and an app
tion object. A Jaguar component is no different. In fact each Jaguar component is a
rate PowerBuilder application. When building a Jaguar component, the applica
object will not require any code, as it is only used for specifying the library search 
and telling the PowerBuilder environment which application is being worked on. In o
to work on objects in PowerBuilder, you must specify a particular application object.
application object library path must contain all of the PowerBuilder libraries that h
the objects that are being developed so that you can save changes.

 A Jaguar component wizard has been provided that will create the application o
and initial PBL as well as the Jaguar component (NVO) and the Jaguar compo
project used to deploy the component. From the PowerBuilder main menu, choose
New or click on the New icon on the tool bar (see figure 6.3) to open the New dialog
as shown in figure 6.4. Click on the Start Wizards tab and select the Jaguar Compo

)LJXUH#916)LJXUH#916)LJXUH#916)LJXUH#916
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 The wizard displays the steps that will be taken to build a Jaguar component ap
tion. Before continuing, make sure that you know the Jaguar server location and h
valid user ID and password that is a member of the Jaguar Admin role.

 The first thing the wizard will require is the name of the application object and
name and location of the PowerBuilder library (PBL). Type in the information as sh
in figure 6.6. The next step will be to adjust the library search path. Any existing Po
Builder libraries can be added to the library list now (see figure 6.7). The library se
path can be modified later using the File | Library List option in the Library Painter.

 The Specify New Component dialog box prompts the developer for the compo
name and a description, as depicted in figure 6.8. The component name specified 

)LJXUH#918)LJXUH#918)LJXUH#918)LJXUH#918
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window in figure 6.8 is the name of the nonvisual object, as it will appear in the Po
Builder PBL. A different name can be defined for the Jaguar component (see figure
This allows PowerBuilder developers to use the naming conventions that they are
familiar with, while implementing a separate naming convention for the Jaguar obj
In this example we let the Jaguar component and the PowerBuilder NVO use the
name.

 
 
 The connection information required for the Jaguar server in which the compo

will be deployed is specified in the Specify Server Information dialog box, illustrate
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figure 6.10. In order for PowerBuilder to connect to the Jaguar server, the server
have an IIOP listener setup on the port defined in the dialog box. Jaguar CTS has a
listener setup on port 9000 by default when it is installed. When the PowerBuilder d
opment environment and the Jaguar CTS server are not on the same machine, 
must have the IIOP listener configured to listen on a host other than localhost. Re
machines cannot access the Jaguar server without changing the listener’s defau
name. This is covered in chapter 3.
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When specifying the Login information for the Jaguar server in the wizard, m
sure that the login ID is a member of the Admin Role, otherwise the wizard ca
deploy the component to the Jaguar server.

 All components in Jaguar are grouped in packages. You cannot install a comp
on Jaguar outside of a package. Packages are covered in detail in chapter 4. Y
place the component being built with the wizard in a new package or in a packag
already exists on the server. You can use the small button next to the Package nam
to browse packages installed on the Jaguar server (see figure 6.11). Only pac
installed on the Jaguar server defined in the Specify Server Information dialog box i
ure 6.10 will be listed. If the Jaguar server has not been started or is not listening 
specified port the developer can continue with the wizard but will not be able to v
the package name.

 The Component type is specified next. A Jaguar component can be defined as 
three types:

■ standard component

■ shared component

■ service component

)LJXUH#9144)LJXUH#9144)LJXUH#9144)LJXUH#9144
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 Select the standard component type (see figure 6.12). Most components will be sta
dard components. The shared component is similar to the PowerBuilder Shared O
A Jaguar shared object forces the component to have only a single instance active
Jaguar kernel. This allows components to share information, cache data, and store
mation on state. The Service components are special Jaguar components that run
background and perform various processing tasks.

 The instance pooling and transaction support options are specified in the nex
dialog boxes, as shown in figures 6.13 and 6.14. When a component supports in
pooling, the actual object instance is not destroyed but placed in a pool for reuse by
client applications. Instance pooling is covered in chapter 8. Transaction support d

)LJXUH#9145)LJXUH#9145)LJXUH#9145)LJXUH#9145
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mines whether or not a component will use the Jaguar Transaction Manager and h
component behaves when it is accessed by other components that have ongoing t
tions. These options are covered in detail in chapter 11. The auto demarcation/de
tion option is enabled for stateless Jaguar components and is covered in detail in c
8.

 A component’s interface describes how client applications and other Jaguar co
nents can interact with it. Jaguar exposes all of the public functions on an object a
of the interface. This information is stored in the Jaguar repository as IDL modu
which is covered in chapter 4. All of the exposed functions must adhere to the CO
IDL specification. Client applications and other Jaguar components can invoke a
the functions exposed on the interface. A PowerBuilder component can choose to e
user events and public instance variables as part of its interface in addition to p
functions (see figure 6.15).

 I do not recommend exposing variables or events as part of the public inter
Access to attributes and events can be provided using method calls. Exposing va
breaks the object-oriented rule of encapsulation. Events are typically used to resp
system events and provide a way to extend and override code easily. CORBA IDL
not support events, so events are made public by creating a function in the prox
maps to the event. The generated function uses a “name mangling” technique so t
event and the function are mapped correctly. This is transparent to PowerBuilder c
and components, but exposing events as part of the interface on a Jaguar com
affects the IDL and how components and clients written in other languages call co
nent methods that are actually events.

)LJXUH#9147)LJXUH#9147)LJXUH#9147)LJXUH#9147
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 CORBA IDL does not support passing NULL values as arguments. PowerBu
components supporting NULL values will have their interfaces altered. An extra a
ment will be added to all public methods indicating which values have a NULL va
This is transparent to PowerBuilder clients and components, but the change to the
face is visible in the IDL and therefore must be managed by components and clients
ten in other languages.

 During development there are two very useful options that can make compo
development easier. They are remote debugging and live editing (see figure 6
Enabling remote debugging on a component allows the developer to use the new r
debugger to walk through server-side code. Anyone who has written a Distributed 
erBuilder application will quickly see the value of this option. The debugger is cove
in chapter 13.

8+2
Make sure that remote debugging is turned off when moving objects into produc
Leaving remote debugging on can impact performance.

 Live editing is another useful feature in development. When Live editing is enab
the PowerBuilder object is deployed to the Jaguar server specified in the Spec
Server Information dialog box (see figure 6.10) whenever the object is saved. This

)LJXUH#9148)LJXUH#9148)LJXUH#9148)LJXUH#9148
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the developer from having to constantly perform the step of launching the project pa
and deploying the object manually. This option should only be used when the pr
specifies the Jaguar server used for development. In order to avoid prematurely d
ing objects to a production server, build a separate project to install components wit
option turned off.

 The project name is defined in the Specify Project dialog box, depicted in figure
on p. 142. The project is where most of the information gathered by the wizard is st
You use the project to actually deploy the object on the Jaguar server. You can
project to deploy several components at once, but they must all be installed to the
package. You can add additional components to the project in the project painter. A
ing convention for projects might be useful to indicate which servers and package
project is deploying to. For example:

p_<ServerName>_<PacakageName>

 Using this convention, a project that deploys components to the JaguarHello pa
on the JagDev server might be named p_JagDev_JaguarHello.

 The final step before finishing with the wizard is to specify the library options use
deploy the PowerBuilder objects to Jaguar (see figure 6.18 on p. 142). The PowerB
objects must be installed on the Jaguar server machine so that they can be insta
The PowerBuilder objects are shipped to the Jaguar server as PowerBuilder dy
libraries (PBD). The PBD option is the only deployment option available, the mac
code (DLL) option is not supported. This actually makes the most sense as it allow
PowerBuilder objects to be used on any platform. A developer has the option of shi
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a separate PBD for each PBL in the library search path of the application object o
solidating all the objects into a single PBD. In addition, the developer can choo
include un-referenced objects in the consolidated PBD. This is important when the 
ponent uses DataWindow objects, which would not be included in the PBD th
deployed to the Jaguar server if you disable this option. An alternative to using
Include Unreferenced Objects option is to specify the objects in the PowerBu
resource (PBR) file.

 Once the library options are defined, the Jaguar component is ready to be cr
Review the characteristics and than click on the Finish button, as shown in figure 6.19
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 The wizard creates the JaguarHello.pbl and a JaguarHello.pbr file. The Ja
Hello.pbl contains the following objects:

■ application object (jaguarhello)

■ project object (p_jaguarhello)

■ user object (n_jaguar_hello)

916916916916 %XLOGLQJ#D#+HOOR#:RUOG#REMHFW%XLOGLQJ#D#+HOOR#:RUOG#REMHFW%XLOGLQJ#D#+HOOR#:RUOG#REMHFW%XLOGLQJ#D#+HOOR#:RUOG#REMHFW

In this chapter we will build the Jaguar object for the classic Hello World example. In
next chapter we will build a client to access this object. The Hello World example
help demonstrate all the basic concepts involved with building a Jaguar application
rest of the book will explore the more advanced features used to build more compli
objects capable of delivering data and handling transactions.

 The Hello World example involves the following steps:

1 Building a Jaguar component

2 Deploying the Jaguar component

3 Generating a Jaguar proxy for the component

4 Building a Jaguar client

5 Testing the application

)LJXUH#914<)LJXUH#914<)LJXUH#914<)LJXUH#914<
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 The overview of the Hello World application is illustrated in figure 6.20. The figu
shows the application running over a network. This example can also be run on a 
machine.

 To start, you will need to create a PBL, application object, and a NVO. I recomm
using the Jaguar Component wizard. Once you generate the PBL and the objects w
wizard, you are ready to begin coding methods and functionality. You can build the
uar Hello World object (n_JaguarHello ) using the Jaguar component wizard or usin
the custom-class option from the New dialog box. Both options will end up in the U
Object painter, where you will write the object. The rest of this example will assume
you used the wizard.

 Before continuing, let’s take a look at a new PowerBuilder 7 feature—the To Do 
The To Do list consists of the steps that a developer must perform in order to comp
specific task. The To Do list, shown in figure 6.21, was generated by the Jaguar w
To open the To Do list, select the Window | To Do List option from the main men
click on the To Do List toolbar icon (see figure 6.22).

 The wizard has already built the project to deploy the Jaguar component, so w
check that off of our list. You will not need a PBR file so we can cross that off the lis

)LJXUH#9153 +HOOR#:RUOG#RYHUYLHZ)LJXUH#9153 +HOOR#:RUOG#RYHUYLHZ)LJXUH#9153 +HOOR#:RUOG#RYHUYLHZ)LJXUH#9153 +HOOR#:RUOG#RYHUYLHZ



Building a Hello World object 145

ld

ject
r by
 (see

Ob-

rated
bject
fter
ts in
he
 the
well. All that is left to do is code your Hello World method. To write the Hello Wor
method you will need to open the User Object painter.

 The easiest way to open the User Object painter is by clicking on the ob
n_JaguarHello  in the library painter. You can also open the user object painte
choosing File | Open from the main menu or by clicking on the Open toolbar option
figure 6.23)

8+2
Double-clicking on the code methods task in the To Do list will launch the User 
ject painter and open the appropriate object.

 When using the menu or toolbar option, you’ll see the Open dialog box, as illust
in figure 6.24. The developer can choose any PowerBuilder object type from the O
Type drop-down list box. In this example we will select the User Objects option. A
selecting the User Objects from the Object Type list, you will see all the user objec
the library highlighted in the Application Libraries list in the top panel. Click on t
object that you wish to open and hit the OK button. This will open up the object in
appropriate painter.
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 Once in the User Object painter, you will notice the new interface that has been 
duced in PowerBuilder 7 (see figure 6.25). To add a new function, choose the In
Function option from the main menu, or click on the Function List tab and right-clic
open the popup menu. Choose the Add option from the popup menu, as shown in
6.26

 A third method is to choose Functions from the drop-down list box above the Ac
label in the Script sheet. After choosing Functions, select the New Function option 
the drop-down list box above the Return Type label (see figure 6.27). A new function
also be added by right-clicking on the area above the script editor where the drop-
list boxes are contained. This will open a popup menu that contains options to add 
function, event, or parameter as well as delete the function.

 Once you’ve added a new function, type the name of the function and specif
return type as a string, as shown in figure 6.28 on p. 148. The function name in
example is of_Hello. The function accepts no arguments and returns a string.

 In the script portion of the screen add the following code:

RETURN "Hello Jaguar!"

 After coding the script for the Hello World function, save the object. We have 
ished building the n_JaguarHello  object.

)LJXUH#9159)LJXUH#9159)LJXUH#9159)LJXUH#9159
)XQFWLRQ#SRSXS#PHQX)XQFWLRQ#SRSXS#PHQX)XQFWLRQ#SRSXS#PHQX)XQFWLRQ#SRSXS#PHQX
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Once you have finished writing your Hello World object you will need to deploy it to 
Jaguar server. If you used the wizard option to build the Jaguar object, you’ve alr
built the Jaguar Component project. If you built the component using the custom 
option instead of the wizard, you will need to build a Jaguar Component project now
the section called Building a Project using the Project Wizard, at the end of this chapter.

 If you enabled the live-editing option, the Jaguar object has already been install
the Jaguar server. When this option is not implemented, the Jaguar compon
deployed through the project. Open the project object in the project painter, and clic
build option (see figure 6.29). That is it! You’ve deployed the Jaguar component on
Jaguar server specified in the project properties.

8+2
The Jaguar server must be started and listening on the specified port using II
successfully deploy objects. In addition, you must supply the login user ID and p
word if you have not selected the Save Login option. If a build fails because the
uar server is not available, the message box, shown in figure 6.30, is displayed
the COMM_FAILURE. If the login is incorrect, a similar message box will displ
with a NO_PERMISSION error, as pictured in figure 6.31.

)LJXUH#915;)LJXUH#915;)LJXUH#915;)LJXUH#915;
7KH#+HOOR#:RUOG#IXQFWLRQ7KH#+HOOR#:RUOG#IXQFWLRQ7KH#+HOOR#:RUOG#IXQFWLRQ7KH#+HOOR#:RUOG#IXQFWLRQ
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 After you have completed the build, log onto the Jaguar server, using the Jaguar
ager, to verify that the package and component have been successfully deploye
package and the component are shown in the Jaguar Manager under the Installed
ages folder of the Jaguar server, as illustrated in figure 6.32 on p. 150. Congratula
you have just built and deployed your first Jaguar object.

)LJXUH#915<)LJXUH#915<)LJXUH#915<)LJXUH#915<
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In order to build additional Jaguar components without creating a new PBL or app
tion object each time, you can use the Jaguar Component Wizard on the Object t
shown in figure 6.33. This wizard is used to generate only the NVO and the pr
object, placing them in an existing PBL.

 The Jaguar Component Wizard will prompt the developer for the PBL in which
new object should be created (see figure 6.34). After this step, the Jaguar Comp
Wizard will continue opening dialog boxes, starting with the one that asks for the c

)LJXUH#9165)LJXUH#9165)LJXUH#9165)LJXUH#9165
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ponent name and properties, shown in figure 6.8. It continues from this point usin
same set of dialog boxes as the Jaguar Component Wizard accessed from the Sta
ards tab.

919919919919 %XLOGLQJ#D#SURMHFW#XVLQJ#WKH#SURMHFW#ZL]DUG%XLOGLQJ#D#SURMHFW#XVLQJ#WKH#SURMHFW#ZL]DUG%XLOGLQJ#D#SURMHFW#XVLQJ#WKH#SURMHFW#ZL]DUG%XLOGLQJ#D#SURMHFW#XVLQJ#WKH#SURMHFW#ZL]DUG

To build a project to deploy a component to Jaguar for a custom-class object, selec
New from the main menu to open the New dialog box. Select the Project tab, and c
the Jaguar Component Wizard, as shown in figure 6.35. This wizard will prompt yo
the PBL in which the generated project will be placed (see figure 6.34) and the na
the project (see figure 6.17).

)LJXUH#9167)LJXUH#9167)LJXUH#9167)LJXUH#9167
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 After this step, the Jaguar component wizard will continue opening dialog bo
starting with the one that asks for the server information, shown in figure 6.10. It co
ues from this point using the same set of dialog boxes as the Jaguar Component 
accessed from the Start Wizards tab, skipping the Project Name dialog box in f
6.17.

91:91:91:91: 6XPPDU\6XPPDU\6XPPDU\6XPPDU\

This chapter has covered the basics on how to build a simple object in PowerBuilde
deploy it to a Jaguar server. After reading this chapter, you should understand how 
the Jaguar wizards in PowerBuilder to build and deploy a Jaguar component. In th
chapter you will build a client application in PowerBuilder that will access your Jag
component.
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